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1 Overview

In the NuMicro® M261 series, XOM (Execute-Only Memory) is a secure ROM region which
forbids any data access. However, the code stores in the XOM region still could be executed
by CPU due to it is accessed by instruction fetch. By forbidden data access path, the code in
XOM could be protected from reading by CPU, DMA, ICE and Flash programing tool. By
allow instruction fetching, the code still could be executed in XOM region. Furthermore, the
M261 supports MOVW, MOVT instructions to encode data within a 32 bits instruction.
Therefore, it is easy to build a “pure instruction code” in “C” language with a compiler which

supporting “execute-only code” compiler option.

In general, XOM could be used to embed a software library into the M261. Due to the
characteristic of XOM, the software library in it could be protected from disassemble and

copy.
A XOM size can be set to the minimum size is 1 page (2 Kbytes) on the M261, and the
maximum can set up to 255 pages (510 Kbytes). In addition, the M261 also allows users to
set up to 4 XOM regions, as shown in Figure 1-1. This feature enables users to use XOM on
the M261 freely and flexibly.

0x0 XOMROBASE XOMR1BASE XOMR2BASE XOMR3BASE
XOMRO XOMR1 XOMR2 XOMR3
XOMROSIZE XOMR1SIZE XOMR2SIZE XOMRSSIZE

Figure 1-1 XOM Configuration
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1.1 XOM Related Configure Address and Registers

The XOM region 0~3 configure address is shown in Table 1-1.

XOM Base

Address

XOM Size

Address

XOM CTRL

Address

XOMROBASE

0x20_0000

XOMROSIZE

0x20_0004

XOMROCTRL

0x20_0008

XOMR1BASE

0x20_0010

XOMRI1SIZE

0x20_0014

XOMR1CTRL

0x20_0018

XOMR2BASE

0x20_0020

XOMR2SIZE

0x20_0024

XOMR2CTRL

0x20_0028

XOMRSBASE

0x20_0030

XOMRSSIZE

0x20_0034

XOMRS3CTRL

0x20_0038

Table 1-1 XOM Configure Address

® XOMRNBASE (n=0~3)
It is XOM Region Base Address configuration. XOMRNBASE is used to set XOM region
base address in APROM region.

® XOMRNSIZE (n=0~3)
It is XOM Region Size configuration. XOMRNSIZE is used to set XOM size from 1 to 255
pages (2k ~510k bytes). The minimum setting is 1 page.

® XOMRNCTRL (n=0~3)
It is XOM Region Control configuration, as shown in Table 1-2. XOMRNCTL is used to
activate XOM region. The Ox5A is default value indicating that the XOM region is
currently in OFF mode. If user writes non-Ox5A to this configuration, the XOM region will
be enabled and in normal mode. If user writes 0x50 to this configuration, the XOM region
is in debug mode.

XOM Mode XOM Active XOM Region Control
Off mode No Ox5A(default value)
Debug mode Yes 0x50

Normal mode Yes Others

Table 1-2 XOM Control Configuration

After setting XOMRNBASE, XOMRNSIZE and XOMRNCTRL, the M261 series must reset
to activate XOM regions.
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FMC XOM status registers are listed in Table 1-3.

Register Address
FMC_XOMROSTS 0x4000_CO0DO
FMC_XOMRI1STS 0x4000_CO0D4
FMC_XOMR2STS 0x4000_CO0DS8
FMC_XOMR3STS 0x4000_CO0ODC
FMC_XOMSTS 0x4000_COEO

Table 1-3 XOM Status Registers

® FMC_XOMRNSTS (n=0~3)
It is XOM Setting Status register. These registers indicate the XOM region base address
and page size.

® FMC_XOMSTS
It is XOM Active Status register. This register indicate the active status of XOMRnN (n=0~3)

Apr 12,2019 Page 5 of 35 Rev 1.00



NUVOoOTON AN0041

2 Using BSP FMC ISP APIs to Configure XOM

2.1 Using FMC ISP APIs to Set and Activate XOM Region

Use the FMC ISP function to configure the XOM base address, size and active control on the
M261. Follow the steps below to configure XOM region:

1.
2.

Execute SYS_UnlockReg() to unlock register protection.

Use FMC_Open() and FMC_ENABLE_AP_UPDATE() of BSP APIs to enable FMC
ISP and APROM update functions.

Use the FMC_ConfigXOM() API to configure XOMRnN (n=0~3), base address, XOM
size and XOM active.

Program the user code into XOM region.

Reset chip to enable the XOM region.

2.2 Using FMC ISP APIs to Remove XOM Region
Follow the steps below to remove XOM region and settings:

1.
2.

3.
4.

Execute SYS_UnlockReg() to unlock register protect

Use FMC_Open() and FMC_ENABLE_AP_UPDATE() of BSP APIs to enable FMC
ISP and APROM update functions

Use the FMC_EraseXOM() API to erase XOMRn (n=0~3) region and settings.

Do chip reset to remove XOM region and settings.
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3 Using Keil® MDK to Configure XOM

Before using Keil® MDK to configure XOM, please install the latest version of Nuvoton Keil®
driver first. The driver version needs to be v6650 or later.

3.1 Using Keil® MDK to Configure XOM Region

Follow the steps below to configure XOM region settings:

1. Open Keil® MDK and select “Project->Options for Target” to enter “Options” page,
as shown in Figure 3-1.

File Edit View | Project | Flash Debug Peripherals Tools 5VCS Window Help

1= | §| Mew pVision Project...
@ ILI Iﬁl @ Mew Multi-Project Warkspace...
Open Project...

Project .
=% Project: XON Close Project
=465 XOMCor Export
=-S5 CMS Manage
B 1

_] Select Device for Target ...

B User Remove ltem

_] ;;\ DptionsforTarget')(DMCode'...I

$J A Clean Targets
=15 Librz

] Build Target

Figure 3-1 Open Keil® MDK Options

2. Click “Option”->"Debug”->"Settings” button to enter the debug setting page then
select "Chip Type” as M261, as shown in Figure 3-2.

Mu-Link Driver Setup - - - — - - @
Debug ]Tmc:e |
Mu-Link Chip Select

Supporting Forum

Driver Version: 68752 |Chip Type: [M261 - I EN: http:/ forum.nuveoton .com./

SC: http:/fwwew nuvoton-ncu.com,’

ICE Version: 6875 Reset Options

Device Family: |Cortex-M Connect: | Normal A
Device ID: Ox0BF11477 Resat: Autodetect -
Port: sw hd Download Options

Max Clock: TMHz 2 r

oK | Cancel

Figure 3-2 Select Chip Type
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3. Click “Option”->"Utilities”->"Settings” button to enter Flash Download page. Click

the “Setting” button in the “Chip Setting” to enter the “M261 Settings” page, as
shown in Figure 3-3.

k] Options for Target 'XOMCode' Y

Deuice] Target ] Output] Listing] User ] C/C++ {ﬁ.Cﬁ]-] Asm ] IJnker] Debug LUtilities
Corfigure Flash Menu Command

{* Use Target Driver for Flash Programming IV Use Debug Driver

v Update Target before Debuaging

" i L
-

Flash Download for M261

— Use Debug Driver —

Flash Select

Rk for Algaorithn

Start: |0x20000000
Size: |0x4000

APROM with 18P -

Prograrmming Algarithm

Download Function
" Erase Full Chip
(% Erase Used Sectol

" Do Mot Erase

v Program Flash
s W Verify Flash

¥ Reset and Run

Flazh Breakpaoint

D escription | Device Type | Device Size | Addresz Ranage

[~ Enable Flash BP
261 512kE Flaz... On-chip Flash 512K 00000000H - 00FF]

Chip Setting

Figure 3-3 M261 Settings

4. After entering the “M261 Settings” page, select “XOM setting” page to enter XOM
setting page, as shown in Figure 3-4.

5. Check XOMO0O~3 to set XOM “Start Address” and “Page Counts”. After configuring
XOM setting then click “OK”.

6. To enable debug mode, check the “Debug Mode” option and repeat above steps.

i M261 Settings — |
Configuration | KPROM Setting  #0M Setting ] Secure Setting]
Fegion Start Addrezs Page Counts Debug Made
W XOM: 0 {00010000 | 10 r
[~ XOM1: 0x [FFFFFFFF | 0 r
[~ XOM2 0x [FFFFFFFF | 0 ~
[~ XOM3: 0x [FFFFFFFF | i r

Figure 3-4 Keil® MDK XOM Setting
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4 Using ICP Programming Tool to Configure XOM

Before using the ICP programming tool to configure XOM, please install the latest version of
ICP programming tool first. The version needs to be v6650 or later.

4.1 Using ICP Programming Tool to Configure XOM Region

Follow the steps below to enter the XOM configure page in the ICP programming tool:
1. Open the ICP programming tool, select chip type “M261” and click “Connect” to
enter the main page.
2. Click “Setting” button to open the “M261 Settings” page, as shown in Figure 4-1.

# Muvoton NuMicro ICP Programming Tool 2.06 - M261 Series . - = &®

Project Chips Teol Language

NUVOTON IE—

Statuz
Chip Connected with Hu-Link2 (ID: 18001163)
Part No. MoEIKIAAE b?[?j%héiglggpﬂnm;51 2, FAM: 55K,
Load File
File Name:  CALDROM hex
File nat load.
File Name:  C:\APROM hex

File: not load. Offzet: Ox 0

Trusted BootCode Info

oTe File N ame——CAQTE aba .
i M261 Settings [
Chip Settings
Config 0: | Configuration | KPROM Settingl #0OM Setting I Securs Settingl
File D ata On-bao
Region Start Addrezz Page Counts Debug Mode
LDROM | 4PROM | LDRO
| @xomo0e  o0m10m0 R

[C]%OM1: 0x |  FFFFFFFF 0

[FIXOM2: 0x | FFFFFFFF 0
Sheeranig []XOM3: 0x | FFFFFFFF 0

[C]LDROM [ 4PF

Figure 4-1 Open M261 Settings and XOM Setting
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3. Enter “XOM Setting” page.

4. Check which XOMO0~3 to fill the XOM “Start Address”, “Page Counts”. After
configuration is finished, click “OK” to return to main page.

5. Click “Options” button to enter the programming setting page, as shown in Figure

4-2.

File Data Orrboard Flash Offline Flagh

LDROM | sPROM | 4PROM_NS | LOROM | 4PROM | APROM_NS | LDROM | 4PROM | 4PROM_NS | Info |
@ B hits
() 16 bits
© 32 bits

Programming

[CILDROM  [CJ4PROM  [C]APROM_NS [¥] Chip Setting | Qoons | [ Gtan |

[T]5ecurekey [ OTP

Figure 4-2 Programming Setting

6. Select “Erase”,” Program”, “Verify”, and “Reset Chip after Programming” options, as
shown in Figure 4-3.
7. Click “OK” to return to main page.

1 rogram Opton — o
O peration

Eraze

Program

Werify

[]wirite Software Serial Mumber

Reszet Chip after Programming
[7] Offine Pragramming Mode

Figure 4-3 Program Option Select

8. Select “Chip Setting” and click “Start” button to program XOM configure settings
and enable XOM, as shown in Figure 4-4.
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File Data On-board Flazh Offline Flazh
LDROM | 4PROM | APROM_NS | LOROM | APROM | APROM_NS | LDROM | APROM | APROM_NS | Info |
@) 8 bits
) 16 bits
) 32 bits
Programming
[]LDROM [T APROM [] &PROM_NS, Chip Setting Options [ Start ]

[ Secure ey  [C]OTP

Figure 4-4 Start Programming

9. Re-enter “XOM Setting” page and uncheck the XOM select option, then return to
main page.

10. Click “Refresh” and then re-enter “XOM Setting” page to check XOM configure
status, as shown in Figure 4-5.

11. To enable debug mode, please check the “Debug Mode” option and repeat above

steps.
B M261 Settings @
Configuration | KPROM Setting | #0M Setting | Secure Setting|
Region Start Addrezz Page Counts Debug Mode
[]=0r0: 0% 00010000 10
[]=0m1: 0% FFFFFFFF 0
[[1=0Mz: 0x | FFFFFFFF 0
[(]®0M2: 0s | FFFFFFFF i

Figure 4-5 Check XOM Status
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4.2 Using ICP Programming Tool to Remove XOM Region
1. Open the ICP programming tool, select chip type “M261” and click “Connect” to
enter the main page.
2. Click “Setting” button to open the “M261 Settings” page, as shown in Figure 4-6.

# Muvoton NuMicro ICP Programming Tool 2.06 - M261 Series . - = &®

Project Chips Teol Language

NUVOTON IlEms——

Statuz

Disconnect Chip Connected with Mu-Link2 [ID: 180017163)

Part No, M2BIKIAAE lﬂ?g‘;%héiél;('__éPHDM:51 2K, Riih:96K
Load File
File Name:  CALDROM. hes
File rot load.
File Name:  C:\APROM hex

File: not load. Offzet: Ox 0
Trusted BootCode Info

oTF File Mamg— CAOTE atn

N
i M261 Settings [
Chip Settings
Config 0: | Configuration | KPROM Settingl #0OM Setting I Securs Settingl
File D ata On-bao
Region Start Addrezz Page Counts Debug Mode
LDROM | 4PROM | LDRO
| @xomo0e  o0m10m0 R

[CI%0M1: 0x | FFFFFFFF 0

[F%0M2 0% | FFFFFFFF 0
Sheeranig []XOM3: 0x | FFFFFFFF 0

[C] LOROM 7] 4PR

Figure 4-6 Open M261 Settings and XOM Setting

3. Enter “XOM Setting”.

4. Check which XOM region to be removed, and then click “OK” to return to the main
page.

5. Select “Option” to enter “program option” page, as shown in Figure 4-7.

6. Select “Erase” and “Verify” options.

7. Click “OK” to return to the main page.
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t_ Progam Opton EG—_—_ — &=
O peration
Eraze
[] Program
Werify
[ write: Software 5 erial Mumber

[] Reset Chip after Programming
[] Offline Programming Mode

Figure 4-7 Program Option Selection

8. Select “Chip Setting” and click “Start” button to remove XOM region data and
settings.

9. Enter “XOM Setting” page and uncheck XOMO.

10. Click “OK” to return to main page.

11. Click “Refresh” button then re-enter “XOM setting” page to check XOM configure
status, as shown in Figure 4-8.

i M261 Settings S

Configuration | KPROM Setting | #0M Setting | Secure Setting|
Region Start Address Page Counts Debug Mode
[C]®OMD: 0w FFFFFFFF 0
[C]0M1: 04 | FFFFFFFF 0
[C]<0M2 0 | FFFFFFFF 0
|
[C]#0M3: 02 | FFFFFFFF 0

Figure 4-8 Check XOM Status
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4.3 Using Erase Whole Target Chip Function to Remove XOM

The XOM region can also be removed using the erase whole chip function, “Tool”-> “Erase
Whole Target Chip” in the ICP programming tool, as shown in Figure 4-9. If this function is
used to remove XOM, all the XOMs region, user CONFIG0~3 and all the code and data on

the Flash will be cleared.

 MNuvoton MuMicro ICP Programming Tool 2.06 - M261 Series 'R ¥ [ = ﬂh,l
Project Chips [Tool ] Language
nuvc Erase Offline Data
Status Create Mu-Link Certification File
Disconmect Create Secure Boot Key File
Part Mo, Create OTP Memaory File b: SEK.
I Erase Whole Target Chip I
Load File
LOROM File: M arme: CALDROM.bex
File niot load.
APROM File: t arme: C:AAPROM. hex
File niat load. Offzet 0x O
Trusted BootCode Info
aTe File Mame:  CAOTP.otp
Chip Settings
Config0 | DsFFFFFFOF  Config3 | DsFFFFFFFF [« Update Histary > -

Apr 12,2019

Figure 4-9 Erase Whole Chip Selection
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5 Configuring XOM and Debugging on Keil® Compiler

5.1 Compiling Execute-only Code

ANO0041

Use Keil® compiler to compile .c file of XOM code. The .c file needs to be set to “Execute-only
code” type. Follow the steps below, as shown in Figure 5-1:
1. Select .c file of XOM code on the Keil® “Project” window.

2. Open “Options” page of the .c file.

3. In “Option” -> “C/C++ (ACB6) “-> “Language/Code Generation”, select “Execute-only

code” option.

Apr 12,2019

File Edit View Project Flash Debug Peripherals Tools SVCS  Window  Help
‘ﬁl | 5 | 'Et& = ;E = .v"a":| ] FMC_Secure_Test
LOAD e A,
| ¥ xomcode Fa&| s & 2@
Project 1 B 1 mainc
=% Project: XOMCade €0 I= 5o
245 XOMCode &1 sv5-> Wi Options for File "xom.c'
w23 CMSIS 62 |}
i &3 Properties  C/C++(ACE) ]
S User 64 int32 t n
1 mainc 65 |_|:_|{ Preprocessor Symbols
%] xom.c =
i . Options for File 'xom.c'... Alt+F7 Define:
=15 Library Ig‘ B I |
B retarget Remaove File ‘xom.c Undefine: |
) cke dh Manage Project Items... Language / Code Generation
] uartc Open xom.c v Execute-only Code Wamings:
j fme.c | 4 Repuild all target files Optimization: | <default> | ¥ Tumw
Sys.C )
Build Target F7 [+ Link-Time Optimization ¥
Translate xom.c [ Split Load and Store Multiple 4
[¥ One ELF Section per Function d
v | Show Include File Dependencies
T T Include |
a0 1 Pﬁhs
isc
e | Controlz |
g2 1
83 Compiler  |xc -std=c11 ~4arget =am-am-none-e:
84 1 control | mexecute-only fno-tti funsigned-ch:
string
85
86 1
87 1
8
89

Figure 5-1 Compile .c File of XOM Code
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5.2 Writing a Scatter File to Specify XOM Address

User can easily assign and program code to any address on Flash by using linker script, a
scatter file description. User can open and edit scatter file by “Project” -> “Options of target” ->
“Linker” -> “Edit”, as shown in Figure 5-2. When compiling a .c file, the compiler will assign the
object code (.0) to specified address on Flash according to the scatter file description.

K Options for Target 'XOMCode'

)

Dievice ] Target ] Output ] Listing ] Uzer ] C:’CH{ACE}] Asm
™ Use Memory Layout from Target Dialog
[ Make RW Sections Position Independent
[ Make RO Sections Position Independent

[~ Dont Search Standard Libraries
[+ Report ‘might fail' Conditions as Emors

Linker ] Debug ] | ilities ]

%/0 Base: ’—
R0 Base: |D<00000000
RAW Base |1x20000000

disable Wamings: |534D.5314

Scatter wom_scatter scf
File:

| El Edt...

Misc
controls

—map —first="startup_M261 o{RESET) —datacompressor=off —irfo=inline —entry Reset_Handler

Linker |-cpu=8-M.Base "o

string

contral  [-ibrany_type=microlib —diag_suppress 63406314 —strict —scatter "xom_scatter scf"

oK

Cancel || Defaults |

Figure 5-2 Open and Edit Scatter File

ANO0041

Below is a scatter file example. It declares a XOMO region located at 0x10000 and assigns

xom.o to this region.

; Scatter file

; XOMO region base address
XOMO0 0x10000

{

;xom.o base address in XOMO region
XOMO_ROM +0

{

Xom.o

}

Apr 12,2019
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5.3 Debugging XOM Region

Write a value other than Ox5A or write 0x50 to XOMRNCTL (n=0~3) control configuration
address and reset chip, the XOM region will be enabled and enter normal mode (not 0x5A) or
debug mode (0x50). In XOM debug mode, user can trace code by Step-Over or Step-Into to
debug the code behavior. This is helpful to locate illegal data access to XOM region which is
caused by the code in XOM region. In other words, the XOM debug mode forbids data access
but doesn’t forbid breakpoint in XOM region while XOM normal mode will forbid both data
access and breakpoint.

XOM is a protect region which cannot be read in disassembly window. All values returned
from XOM region by data read are Oxffff_ffff, as shown in Figure 5-3.

Registers o @ Disassembly
Register |\u’alue | 45: c= a/ b
= Core 46:
RO (O00003ES &40x00010034 FFFFFFFF DCI.W OxEfEEfEEf ; 2 Undefined
R P — 0x00010038 FFFFFFFF DCI.W OxEEEE££Ef ; ? Undefined
R (<000000FA 0x0001003C FFFFFFFF DCI.W OxffEEfEEf : ? Undefined
0x00010040 FFFFFFFF DCI.W OxEfEFffFFff ; ? Undefined
Re 100000008 0%00010044 FFFFFFFF DCI.W OxffEEfEEf : ? Undefined
RS (00000009 aed L
R6 (xDO00000A =3 Hintsd_tocs
R7 IxFFFFFFFF 24
RS OxFFFFFFFF 25: )
Ry DeFFFFEFFE 000010048 FFFFFFFF DCI.W OxfEEE£EEf ; ? Undefined
R10 eFFFFFEFF 0x0001004C FFFFFFFF DCI.W OxEEEEEEEE ; ? Undefined
R11 DeFFFFFFFE 000010050 FFFFFFFF DCI.W OxfEEE£EEf ; ? Undefined
Ri2 00000000 {q_xooomos& FFFFFFFF DCI.W OxEEfEE£EEEf : ? Undefined
R14 (LR} 00001367 J main.c $j AOM.C
= =
+- xPSR (21000000 i
38 recurn c;
+- Banked 39 |
System a0 L
Inteml 41 int32 t XOM Div(int32 t a, int32 t b)
42 01
43 'JintSZ_t c;
44
M 45||] c= a2/ b:
46
47 recurn c;
48 |}
49
50 L
51 int32_t XOM Sum(int32_t *pbuf, int32_t n)
52 0¢
53? int32_t i:

Figure 5-3 Trace XOM Code in Debug Mode

To make sure the code in XOM region is well protected, user must re-set XOM to normal
mode after debugging. When the XOM region is in normal mode, the XOM region cannot be
traced. It is forbidden to step into or set breakpoint in XOM region when XOM in normal mode,
as shown in Figure 5-4.
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Registers

1 Disassembly

ANO0041

Register

El

BFFFFFFFF
FFFFFFFF
BFFFFFFFF
FFFFFFFF
BFFFFFFFF

20000700

0x00001346 9006 5TR rd, [sp, #0x18]
Ox00001348 4608 MOV rd, rl
0x00001342 9908 LDR rl, [sp, #0r18]
0x0000134C FOOOF82E8 EBL _ Oprincf (0x00001320)
12a: printf ("1000 / 250 = %d\n", XOM Div (1000, 250)};
127:
=>0800001350 F24031E8 MOVW rl, #0x3e8
Ox00001354 22FA MOWS r2,#¥0xfa
0x00001356 9005 STR r0, [sp, $0x14]
0x00001358 4608 MOV rd, rl
Ox00001358 4611 MOW rl,r2
0x0000135C FOOEFE&S EBL XCOM Diwv (0x0001002a)
Ox00001360 Fe4151FS MOV rl, #¥0x1df9
0x00001364 F2C00100 MOVT rl, %0
Ox00001368 9004 STR r0. M=o, #0x101
I
] mainc ] xom.c
120
121 /* Run XOM function */
122 printf ("\n"};
123 printf (" 100 + 200 = %d\n", XCM _Add (100, 200));
124 printf (" 500 - 100 = %d\n", XOM Sub (500, 100)):
125 printf (" 200 * 100 = %d\n", XOM Mul (200, 100));
[ 126 princf ("1000 / 250 = 3d\n", XOM Diw (1000, 250)):
127
128 printf ("\n"):
129 printf ("l + 2 +..+ 10 = %d\n", XOM Sum (Numbrray, 10));
130
131 while (1)
132 }
ALEE
134 J#*% (C) COPYRIGHT 2016 Nuvoton Technology Corp. #*##/
135

Figure 5-4 Trace XOM Code in Normal Mode

Note: If the code is trapped or executed too long in XOM region under normal mode, it may
cause ICE error as ICE is forced to be disabled when code is running in a locked XOM region.
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6 Precautions on Using XOM
Users need to pay attention to the following when using XOM:

1. XOM region base address can only be set in APROM and XOM region cannot be
set over APROM.

2. Configuring XOM region needs to set XOMRNBASE > XOMRNSIZE and
XOMRNCTRL (n= 0~3) at the same time. After finishing the configuration, chip has
to reset to enable XOMs.

3. To disable an activated XOM region, it needs XOM page erase or whole chip erase.
XOM page erase will erase the specified XOM region, and whole chip erase will
erase all XOM regions.

4. Itis recommended to write O0x0 to XOMRNCTRL (n=0~3) to activate XOM region.

5. Removing XOM region needs to use XOM page erase and fill correct XOM base
address. After doing chip reset, the XOM region and settings will be cleared.

6. XOM regions cannot be overlapped.

7. XOM region base address must be page alignment.

8. Never set XOM region based to 0x0000_0000. Otherwise, it will fail to boot from
APROM.

9. Because data read from XOM region will be Oxffff_ffff when XOM is activated, the
“Verify Memory Code” of the IDE tool should be disabled when developing code
within an activated XOM region.

10.When configuring XOM is failed, e.g. non-page alignment base address, chip needs

to do “Whole Chip Erase” to remove all XOM region and settings.
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7 XOM Sample Code

7.1 Sample Code Description

The FMC_XOMLIib sample code demonstrates how to compile and build XOM library. There
are two project files in FMC_XOMLib: XOMCode.uvprojx and XOMLib.uvprojx.
FMC_XOMCode is used to build the code for XOM region.

XOMCode Project

% XOM Region

Build
xomlib.c| | .map XOM
code

XOMAddr Utility

APROM

Update API
address

Figure 7-1 Build XOMCode Project

After XOMCode.uvprojx compilation is done, the IDE tool will execute XOMAddr.exe utility.
The XOMAddr.exe refers to \listt XOMCode.map to update the API's address in xomlib.c in
\XOMLIib\, as shown in Figure 7-1.

XOM Project

Build <—M

xomlib.lib

Figure 7-2 Build XOMLib Project

XOMLIib is used to build the XOM library which could be included with other projects.
XOMLib.uvprojx compiles xomlib.c and results in a xomib.lib file in \XOML.ib\lib\, as shown in
Figure 7-2. The FMC_XOMLibDemo sample code will use xomlib.h and xomlib.lib to call the
functions in XOM region.
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In FMC_XOMCode project, the code of XOM library in xom.c file option must be set as
“Execute-only code“. The location of XOM library (xom.o) address is assigned at 0x10000 in
xom_scatter.scf file. After compiling and downloading the XOMCode project, the XOM region
is not enabled yet. User can enable XOM region manually by the methods mentioned in
above chapters.

For example, use Options->Utilities->Settings->Setting->XOM Setting to set XOM base
address and XOM size, as shown in Figure 7-3. After the XOM configure settings, user can
execute chip reset to enable XOM region.

-
ﬂ Cptions for Target "XOMCode' I P
F
Device ] Target I Output I Listing] User ] CAC+ {AC'E}] Asm ] Linker I Debug
Corfigure Flash Menu Command
* Use Target Driver for Flash Programming [# Use Debug Driver
— Use Debug Driver — [¥ Update Target before Debugging
Flash Download for M261 2
Flazh Select RAkd far Algorithm Download Function
| L L
51 M261 Settings @l ¥ Program Flash
- s v Werfy Flash
Configuration | KPROM Setting | #0M Setting § Secure Setting]
v Reset and Run
Reqion Start Address Page Counts Debug Maode Flazh Breakpaint
¥ WOMD: 0 [00010000 | 10 r B Fflo s 1P
Chip Setting r
[~ %OM1: 0x [FFFFFFFF | 0 r
-
il
[~ %OM2 0x |FFFFFFFF | 0 r N -
— 4 [~ %OM3: 0x |FFFFFFFF | 0 m —
- F

Figure 7-3 Use Keil® MDK to Set XOM Region

7.2 XOMCode Project

The XOMCode project is a complete project and can be executed alone. It is used to develop
and test the XOM code. In main.c bellow, it initializes the MCU and call XOM functions to test
them.

main.c

#include <stdio.h>
#include "M261.h"
#include "xomapi.h"

#define PLL_CLOCK 6400000
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void SYS_Init(void)

{

int32_t main(void)

{

uint32_t i, u32Data, u32Status, ret;
int32_t NumArray[10] ={1, 2, 3,4, 5, 6, 7, 8, 9, 10};

/* Unlock protected registers */
SYS_UnlockReg();

/* Init System, IP clock and multi-function I/0. */
SYS_Init();

/* Configure UART: 115200, 8-bit word, no parity bit, 1 stop bit. */
UART_Open(UARTO, 115200);

/*
This sample code is used to show how to build an XOM library.

The location of XOM region is defined by scatter file: xom_scatter.scf
The API header file is xomapi.h

The XOM functions are implemented in xom.c

This project is only used to build code for XOM region and test its functions.

To enable XOM region, please use "NuMicro ICP Programming Tool".

example flow:
1. Build XOMlib
2. Download XOMlib code by press key "F8" in Keil® MDK.

3. Open "NuMicro ICP Programming Tool" to enable XOM region and according to

xom_scatter.scf settings.

4. The library (xomlib.o) and header (xomlib.h) is located at 1lib directory.
5. Pass xomlib.o & xomlib.h to the people who will call the functions in XOM.

*/

printf("\n\n");
printf("+ +\n");
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printf("| FMC XOM Library Build Example  |\n");
printf("+ +\n");

/* Unlock protected registers */
SYS_UnlockReg();

/* Enable FMC ISP function and enable APROM active*/
FMC_Open();
FMC_ENABLE_AP_UPDATE();

/* Read User Configuration */
printf("\n");
printf("XOM Status = 0x%X\n", FMC->XOMSTS);

/* Run XOM function */

printf("\n");

/* Call and execute XOM library APIs */
printf(" 100 + 200 = %d\n", XOM_Add(100, 200));
printf(" 500 - 100 = %d\n", XOM_Sub(500, 100));
printf(" 200 * 100 = %d\n", XOM_Mul(200, 100));
printf("1000 / 250 = %d\n", XOM_Div(1000, 250));

printf("\n");
printf("1 + 2 +..+ 10 = %d\n", XOM_Sum(NumArray, 10));

while(1);

xom_scatter.scf
Specify the location of the XOM.o object file in XOMO region.

; XOM@ region base address at 0x10000
XOMO 0x10000

{
XOMO_ROM +0

{

; Execute region of xom.o from ©x10000

Xom.o
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B

XOMAPI.h
Declare XOM library APIs header file.

#ifndef _XOMAPI_H_
#define _XOMAPI_H_

int32_t XOM_Add(int32_t a, int32_t b);
int32_t XOM_Sub(int32_t a, int32_t b);
int32_t XOM_Mul(int32_t a, int32_t b);
int32_t XOM_Div(int32_t a, int32_t b);
int32_t XOM_Sum(int32_t *pbuf, int32_t n);

#endif

Xxom.c

The XOM_Add(), XOM_Sub(), XOM_Mul(), XOM_Div(), XOM_Sum() are XOM library APIs.
Because the code of xom.c needs to download to XOM region, this xom.c file must set
“Execute-only code” compiler option to generate execute-only code, as shown in Figure 7-4.
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File Edit WView Project Flash Debug

| LOAD
¥4 | XOMCode

Project a B
=t Project: XOMCode
£ %5 XOMCode
£3 CMsis

=G User

_1 main.c

@ | ||

Peripherals Tools SVCS  Window Help
: | L‘S FMC_Secure_Test
EREIN - R A

_] main.c
&0 /* Bet multi-function pins for UARTO
6l 5Y5->GPE_MFPH = (5Y5->GPE_MFPH & (~(U
62 H
63

€4 int32_ t main(void)

65L|:_|{

I ,;:\ Options for File 'xom.c'... Alt+F7

=5 Library
- 1 retarnet.c
Kk Options for File “xom.c'

Remove File ‘xom.c'

Properties |

Preprocessor Symbols

Define: |

Undefine: |
Language / Code Generation
¥ Execute-only Code
[¥ Link-Time Optimization

[+ Split Load and Store Muttiple
[ One ELF Section per Function

Wamings: |<unspecified> hd
Optimization: | <defautt> +| [¥ Tum Wamings into Emors

[¥ Plain Charis Signed
[¥ Read-Only Position Independent
[+ Read-Write Position Independent

Language C: |<default: hd
Language C++: |<default: hd

[+ Short enums/wchar
[+ use RTTI
[+ No Auto Includes

Include |
Paths

Misc |
Controls

Compiler

string

e std=c11 -target=am-am-none-eabi -march=amvEm base <
contral -mexecute-only fno+tti funsigned-char

[ ok

|| Cancel || Defaults |

Figure 7-4 Generate Execute-Only Code

ANO0041

#include <stdio.h>
#include "M261.h"

int32_t XOM_Add(int32_t a, int32_t b)

{

uint32_tc;

c=a+h;

return c;

int32_t XOM_Sub(int32_t a, int32_t b)

{
uint32_tc;
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c= a-b;

return c;

int32_t XOM_Mul(int32_t a, int32_t b)

{
uint32_tc;

c= a*b;

return c;

int32_t XOM_Div(int32_t a, int32_t b)

{
uint32_tc;

c= alb;

return c;

int32_t XOM_Sum(int32_t *pbuf, int32_t n)
{

int32_ti;

int32_t i32Sum,;

i32Sum = 0;
for(i=0;i<n;i++)
{

i32Sum += pbuf{i];

return i32Sum;

}

7.3 FMC_XOMLibDemo

The FMC_XOMLibDemo sample code demonstrates how to compile and link xomlib.lib which
is generated from FMC_XOMLib. Before test FMC_XOMLibDemo project, XOM code must
has been downloaded and activated in FMC_XOMCode project.
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To call XOM functions from a new project, it should do:

1. First, add xomlib.lib to project and set the file location of xomlib.h in “Option” -> “C/C++
(AC6)” -> “Include Paths”, the compiler can find these two files when execute compile.

2. Include xomlib.h header file in main.c.
3. Call the XOM APIs.

Main.c

#include <stdio.h>
#include "M261.h"
#include "xomlib.h"

#define PLL_CLOCK 6400000

void SYS_Init(void)
{

int32_t main(void)
{
extern void func(void);
uint32_t i, u32Data, u32Status, ret;

/* Unlock protected registers */
SYS_UnlockReg();

/* Init System, IP clock and multi-function I/O. */
SYS_Init();

/* Configure UARTO: 115200, 8-bit word, no parity bit, 1 stop bit. */
UART_Open(UARTS5, 115200);

/*
This sample code is used to show how to call XOM libary.
The XOM library is built by XOMLib project.

User need to add include path of xomlib.h and add object file xomlib.o to use XOM
library built by XOMLib project.

*/

printf("\n\n");
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printf("+ +\n");
printf("] Demo how to use XOM library Sample Code [\n");
printf("+ +\n");

/* Run XOM function */

printf("\n");

/* Call and execute XOM library APls */

printf(" 100 + 200 = %d\n", XOM_Add(100, 200));
printf(" 500 - 100 = %d\n", XOM_Sub(500, 100));
printf(" 200 * 100 = %d\n", XOM_Mul(200, 100));
printf("1000 / 250 = %d\n", XOM_Div(1000, 250));

printf(*\n");
printf(*1 + 2 +..+ 10 = %d\n", XOM_Sum(NumArray, 10));

while(1);

xomlib.h
XOM APIs library header file generates from compile FMC_XOMLib sample code.

/******************************************************************************

* This file is auto-generated by Nuvoton XOM tool.

* Copyright (C) 2016 Nuvoton Technology Corp. All rights reserved.
*****************************************************************************/
#ifndef _XOMLIB_H__

#define _XOMLIB_H_

/* Include extern XOM library APIs header */
extern int32_t (*XOM_Add)(int32_t a, int32_t b);
extern int32_t (*XOM_Div)(int32_t a, int32_t b);

extern int32_t (*XOM_Mul)(int32_t a, int32_t b);

extern int32_t (*XOM_Sub)(int32_t a, int32_t b);
extern int32_t (*XOM_Sum)(int32_t *pbuf, int32_t n);

#endif

7.4 FMC_XOM
This sample code shows how to use ISP command to configure or remove XOM region.

The sample code is located in bsp\SampleCode\StdDriver folder. The procedure to use this
sample code is as follows:
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Compile sample code and download code to chip

Reset chip

Configure XOMRO settings and reset chip to active XOMRO
Call Lib_XOM_ADD() function in XOMRO region.

Remove XOMRO setting and clear XOMRO data.

a s wbdPeE

main.c

#include <stdio.h>
#include "M261.h"

#define PLL_CLOCK 6400000

#define XOMRO_Base 0x10000

extern int32_t Lib XOM_ADD(uint32_t a, uint32_t b);

void SYS_Init(void)
{

int32_t main(void)

{
uint32_t i, u32Data, u32Status, ret;

/* Unlock protected registers */
SYS_UnlockReg();

/* Init System, IP clock and multi-function I/O0. */
SYS_Init();

/* Lock protected registers */
SYS_LockReg();

/* Configure UARTO: 115200, 8-bit word, no parity bit, 1 stop bit. */
UART_Open(UARTO, 115200);

/*
This sample code is used to show how to use StdDriver API to enable/erase XOM.
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*/

printf("\n\n");

printf("+ +\n");
printf("| FMC XOM config & erase Sample Code [\n");
printf("+ ----+\n");

/* Unlock protected registers */
SYS_UnlockReg();

/* Enable FMC ISP function and enable APROM active*/
FMC_Open();
FMC_ENABLE_AP_UPDATE();

printf("XOM Status = 0x%X\n", FMC->XOMSTS);
printf("Any key to continue...\n");
getchar();

/* Config XOMRO */
if(FMC_GetXOMState (XOMRO) == 0)

{
/* Configure XOMRO base address and size */
u32Status = FMC_ConfigXOM(XOMRO, XOMRO_Base, 1);
if(u32Status)
printf("XOMRO Config fail...\n");
else
printf("XOMRO Config OK...\n");
printf("\nAny key to reset chip to enable XOM regions...\n");
getchar();
/* Reset chip to enable XOM region. */
SYS_ResetChip();
/* After chip reset, XOMRO will be enabled*/
while(1) {};
}

/* Run XOM function */
printf("\n");
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u32Data = Lib_XOM_ADD(100, 200);
printf(" 100 + 200 = %d\n", u32Data);

printf("\nXOMRO active success....\n");
printf("\nAny key to Erase XOM...\n");
getchar();

if(FMC->XOMSTS & 0x1) == 0x1)
{
/* Erase XOMRO region and settings */
if(FMC_EraseXOM(XOMRO0) == 0)
printf("Erase XOMRO....OK\n");
else
printf("Erase XOMRO....Fail\n");

printf("\nAny key to reset chip...\n");
getchar();

/* Reset chip to finish erase XOM region. */

SYS_ResetChip();
/* After chip reset, XOMRO will be cleared */

while(1);

XOM_Add.c

This is the XOM code for test in FMC_XOM project. The “Execute-only code” compiler option
must be enabled.

#include <stdio.h>
#include "M261.h"

int32_t Lib XOM_ADD(uint32_t a, uint32_t b)

{
uint32_tc;
c= a+b;
return c;
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Xom_scatter.scf
It specifies the location of the xom_add.o object file in XOMO region.

; Specified XOM@ base address at 0x10000
XOMO 0x10000

{
XOM_ROM +0

{

; Execution region of xom_add.o from 0x10000

xom_add.o
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8 Conclusion

The XOM function in the NuMicro® M261 series provides a secure environment for project
development. User can protect the source code not allowed to be accessed by setting the
code region as a XOM region. No one can attempt the data in the XOM region. Such XOM
feature ensures that the user can develop application more safely.
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Revision History

Date Revision Description

2019.04.12 1.00 1. Initially issued.
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Important Notice

Nuvoton Products are neither intended nor warranted for usage in systems or equipment, any
malfunction or failure of which may cause loss of human life, bodily injury or severe property damage.
Such applications are deemed, “Insecure Usage”.

Insecure usage includes, but is not limited to: equipment for surgical implementation, atomic energy
control instruments, airplane or spaceship instruments, the control or operation of dynamic, brake or
safety systems designed for vehicular use, traffic signal instruments, all types of safety devices, and
other applications intended to support or sustain life.

All Insecure Usage shall be made at customer’s risk, and in the event that third parties lay claims to
Nuvoton as a result of customer’s Insecure Usage, customer shall indemnify the damages and liabilities
thus incurred by Nuvoton.

Flease note that all data and specifications are subject to change without notice.
All the trademanrks of products and companies mentioned in this datasheef belong to their respective owners.
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